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This	tutorial	teaches	you	how	to	take	an	NI-DAQmx	measurement	in
LabVIEW	7.x	or	later	using	the	DAQ	Assistant.	The	DAQ	Assistant	is	a
graphical	interface	for	configuring	measurement	tasks,	channels,	and
scales.	You	also	can	use	the	DAQ	Assistant	to	generate	NI-DAQmx	code
from	the	task.
In	this	tutorial,	you	create	a	voltage	measurement	task	using	the	DAQ
Assistant.	You	then	learn	how	to	edit	the	task	and	generate	code	from	the
task	in	LabVIEW.

Note		This	tutorial	assumes	you	are	familiar	with	LabVIEW.	If	you
are	a	new	user	of	LabVIEW	or	are	unfamiliar	with	the	LabVIEW
Express	VIs,	refer	to	the	Getting	Started	with	LabVIEW	manual.

This	document	describes	NI-DAQmx.	For	information	on	Traditional	NI-
DAQ	(Legacy),	refer	to	the	Measurement	and	Automation	Explorer	Help
for	Traditional	NI-DAQ	(Legacy).
To	navigate	this	help	file,	use	the	Contents,	Index,	and	Search	tabs	to
the	left	of	this	window.
To	comment	on	National	Instruments	documentation,	refer	to	the	National
Instruments	Web	site.
©	2003–2008	National	Instruments	Corporation.	All	rights	reserved.
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Conventions
This	help	file	uses	the	following	conventions:

» The	»	symbol	leads	you	through	nested	menu	items	and
dialog	box	options	to	a	final	action.	The	sequence	File»Page
Setup»Options	directs	you	to	pull	down	the	File	menu,
select	the	Page	Setup	item,	and	select	Options	from	the	last
dialog	box.
This	icon	denotes	a	tip,	which	alerts	you	to	advisory
information.
This	icon	denotes	a	note,	which	alerts	you	to	important
information.
This	icon	denotes	a	caution,	which	advises	you	of
precautions	to	take	to	avoid	injury,	data	loss,	or	a	system
crash.

bold Bold	text	denotes	items	that	you	must	select	or	click	on	in	the
software,	such	as	menu	items	and	dialog	box	options.	Bold
text	also	denotes	parameter	names,	emphasis,	or	an
introduction	to	a	key	concept.

dark	red Text	in	this	color	denotes	a	caution.
green Underlined	text	in	this	color	denotes	a	link	to	a	help	topic,

help	file,	or	Web	address.
italic Italic	text	denotes	variables	or	cross	references.	This	font

also	denotes	text	that	is	a	placeholder	for	a	word	or	value
that	you	must	supply.

monospace Text	in	this	font	denotes	text	or	characters	that	you	should
enter	from	the	keyboard,	sections	of	code,	programming
examples,	and	syntax	examples.	This	font	is	also	used	for
the	proper	names	of	disk	drives,	paths,	directories,
programs,	subprograms,	subroutines,	device	names,
functions,	operations,	variables,	filenames,	and	extensions.



Introduction	to	Taking	an	NI-DAQmx
Measurement	in	LabVIEW
This	tutorial	teaches	you	how	to	take	an	NI-DAQmx	measurement	in
LabVIEW	7.x	or	later	using	the	DAQ	Assistant.	The	DAQ	Assistant	is	a
graphical	interface	for	configuring	measurement	tasks,	channels,	and
scales.	You	also	can	use	the	DAQ	Assistant	to	generate	NI-DAQmx	code
from	the	task.
In	this	tutorial,	you	create	a	voltage	measurement	task	using	the	DAQ
Assistant.	This	tutorial	teaches	you	how	to:

Launch	the	DAQ	Assistant	by	using	the	DAQ	Assistant	Express	VI
in	LabVIEW
Configure	a	voltage	task	in	the	DAQ	Assistant
Test	the	task	using	test	panels
Edit	the	task
Generate	the	code	to	run	the	task
Note		This	tutorial	assumes	you	are	familiar	with	LabVIEW.	If	you
are	a	new	user	of	LabVIEW	or	are	unfamiliar	with	the	LabVIEW
Express	VIs,	refer	to	the	Getting	Started	with	LabVIEW	manual.

Next:	Before	You	Begin



Before	You	Begin
To	use	this	tutorial,	you	must	have	the	following	software	and	hardware
installed	in	your	system:

LabVIEW	8.x	or	later
NI-DAQmx	from	NI-DAQ	8.x	or	later,	including	LabVIEW	7.x	or
later	support	files
A	data	acquisition	(DAQ)	device,	physical	or	simulated,	that	is
supported	by	NI-DAQmx	and	is	connected	to	a	voltage	signal.
Refer	to	the	Measurement	&	Automation	Explorer	Help	for	NI-
DAQmx	for	instructions	on	creating	an	NI-DAQmx	simulated
device.	Refer	to	the	NI-DAQ	Readme	file	to	see	if	NI-DAQmx
supports	your	device.

Refer	to	the	DAQ	Getting	Started	Guide	and	the	device	documentation
for	information	about	installing	and	configuring	the	software	and
hardware.

Previous:	Introduction	to	Taking	an
NI-DAQmx	Measurement	in	LabVIEW

Next:	Channels	and
Tasks	in	NI-DAQmx



Channels	and	Tasks	in	NI-DAQmx
A	physical	channel	is	a	terminal	or	pin	at	which	you	can	measure	or
generate	an	analog	or	digital	signal.	A	virtual	channel	is	a	collection	of
property	settings	such	as	a	name,	a	physical	channel,	input	terminal
connections,	the	type	of	measurement	or	generation,	and	can	include
scaling	information.	In	NI-DAQmx,	virtual	channels	are	integral	to	every
measurement.	In	Traditional	NI-DAQ	(Legacy)	and	earlier	versions,
configuring	virtual	channels	is	an	optional	way	to	record	which	channels
are	being	used	for	different	measurements.
In	NI-DAQmx,	you	can	configure	virtual	channels	with	the	DAQ	Assistant,
which	you	can	open	from	MAX	or	your	application	software.	You	also	can
configure	virtual	channels	with	the	NI-DAQmx	API	in	your	application
program.	In	Traditional	NI-DAQ	(Legacy),	you	configure	virtual	channels
using	MAX.
A	task,	an	important	concept	for	NI-DAQmx,	is	a	collection	of	one	or	more
virtual	channels	with	timing,	triggering,	and	other	properties.
Conceptually,	a	task	represents	a	measurement	or	generation	you	want
to	perform.	You	can	set	up	and	save	all	of	the	configuration	information	in
a	task	and	use	the	task	in	an	application.
In	NI-DAQmx,	you	can	configure	virtual	channels	as	part	of	a	task	or
separate	from	a	task.	Virtual	channels	created	inside	a	task	are	local
virtual	channels.	Virtual	channels	defined	outside	a	task	are	global	virtual
channels.	You	can	create	global	virtual	channels	in	MAX	or	in	your
application	software	and	then	save	them	in	MAX.	You	can	use	global
virtual	channels	in	any	application	or	add	them	to	a	number	of	different
tasks.	If	you	modify	a	global	virtual	channel,	the	change	affects	all	tasks
in	which	you	reference	that	global	virtual	channel.

Previous:	Before	You	Begin Next:	1.	Launch	the	Assistant



1.	Launch	the	DAQ	Assistant	Express	VI
You	can	launch	the	DAQ	Assistant	in	several	ways.	Complete	the
following	steps	to	launch	the	DAQ	Assistant	by	placing	the	DAQ
Assistant	Express	VI	on	the	block	diagram	in	LabVIEW.

1.	 Open	a	blank	VI	in	LabVIEW.
2.	 Place	the	DAQ	Assistant	Express	VI	on	the	block	diagram.

The	DAQ	Assistant	launches,	starting	with	the	Create	New	dialog	box.

Previous:	Channels	and	Tasks	in	NI-DAQmx Next:	2.	Create	the	Task



2.	Create	the	Task
In	the	Create	New	Express	Task	dialog	box	of	the	DAQ	Assistant,
complete	the	following	steps	to	create	a	task	to	measure	voltage	from	the
DAQ	device.

1.	 Select	Acquire	Signals.
2.	 Select	Analog	Input	for	the	I/O	type.
3.	 Select	Voltage	for	the	measurement	to	perform.
4.	 In	Supported	Physical	Channels,	select	the	physical	channel	on

the	DAQ	device	to	which	you	connected	the	voltage	signal.
5.	 Click	Finish.

The	DAQ	Assistant	task	configuration	screen	launches.

Previous:	1.	Launch	the	DAQ	Assistant Next:	3.	Configure	the	Task



3.	Configure	the	Task
After	you	create	a	task,	you	can	configure	channel-specific	settings	such
as	custom	scaling,	input	range,	and	terminal	configuration.	You	also	can
configure	task-specific	settings	such	as	timing	and	triggering.
To	configure	the	voltage	measurement	task,	complete	the	following	steps.

1.	 Specify	the	input	range.	You	can	use	the	default	values.
2.	 Select	the	terminal	configuration	you	used	to	connect	the	signal.

3.	 Under	Timing	Settings,	select	N	Samples	as	the	Acquisition
Mode.	Enter	100.00	for	Samples	To	Read,	and	enter	1000.00	for
Rate	(Hz),	as	shown	in	the	following	figure.

Note		This	example	does	not	use	custom	scaling	or	triggering.	To
learn	about	scaling	and	triggering,	refer	to	the	NI-DAQmx	Help.
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4.	Test	the	Task
You	can	view	data	acquired	in	the	DAQ	Assistant	to	test	the	task	and
signal	connection.	Click	Run	to	test	the	task.	Data	acquired	appears	in
the	graph.	Verify	that	you	are	acquiring	expected	data	and	that	you
connected	the	signal	properly.	If	necessary,	modify	any	settings	and	run
your	task	again.

Click	OK	when	you	finish	testing	your	task.

Previous:	3.	Configure	the	Task Next:	5.	Edit	the	Task



5.	Edit	the	Task
If	you	want	to	make	changes	to	your	task	later,	you	can	open	the	task
using	the	DAQ	Assistant	Express	VI	in	LabVIEW.
Complete	the	following	steps	to	edit	the	voltage	task	to	acquire	data
continuously:

1.	 Double-click	the	DAQ	Assistant	Express	VI	on	the	block	diagram
in	LabVIEW.

2.	 When	the	DAQ	Assistant	launches,	select	Continuous	Samples
for	the	Acquisition	Mode.

3.	 Click	OK.
4.	 Save	the	VI	as	MyVoltageTask.vi.

Previous:	4.	Test	the	Task Next:	6.	Generate	Code



6.	Generate	Code
Using	the	DAQ	Assistant,	you	have	three	options	for	generating	code	in
LabVIEW	from	a	task	or	channel:
Example—Generates	all	the	code	necessary	to	run	the	task	or	channel,
such	as	VIs	needed	to	read	or	write	samples,	VIs	to	start	and	stop	the
task,	loops,	and	graphs.	Choose	this	option	if	you	want	to	run	the	task	or
channel	you	created	to	verify	that	it	works	or	to	use	your	configuration	in
a	simple	application.	In	LabVIEW,	this	option	adds	to	the	VI	you	are
working	in.	The	generated	code	is	a	simple	NI-DAQmx	example	that	you
can	then	modify	for	your	application.
Configuration—Generates	the	code	that	replicates	the	configuration	of
the	tasks	and	channels.	LabVIEW	replaces	the	DAQmx	task	name
control	with	a	subVI	that	contains	VIs	and	property	nodes	used	for
channel	creation	and	configuration,	timing	configuration,	and	triggering
configuration	used	in	the	task	or	channel.	Choose	this	option	if	you	want
to	deploy	your	application	to	another	system.	Refer	to	Deployment	in	the
NI-DAQmx	Help	located	at	Start»All	Programs»National
Instruments»NI-DAQ	for	more	information.
When	you	generate	Configuration	code,	the	link	between	the	application
and	the	DAQ	Assistant	is	lost.	Any	changes	you	make	to	the
configuration	code	are	not	reflected	in	the	DAQ	Assistant.	You	can
regenerate	Configuration	code	from	the	DAQ	Assistant,	but	the
regenerated	code	does	not	incorporate	previous	changes	that	you	made
to	the	code.

Caution		Although	generated	configuration	code	includes	code	to
create	virtual	channels	and	tasks,	it	does	not	include	code	to
create	scales.	If	you	generate	configuration	code	for	deployment	of
applications	that	include	scales,	you	must	ensure	that	the	scales
are	configured	in	the	target	computer.	Refer	to	Deployment	in	the
NI-DAQmx	Help	located	at	Start»All	Programs»National
Instruments»NI-DAQ	for	more	information.

Configuration	and	Example—Generates	both	Configuration	code	and
Example	code	for	the	task	or	channel	in	one	step.

Tip		If	you	configure	a	task	using	the	DAQ	Assistant	Express	VI,
you	can	right-click	the	VI	and	select	Generate	NI-DAQmx	Code	to



generate	configuration	and	example	code.	The	code	replaces	the
DAQ	Assistant	Express	VI.

Complete	the	following	steps	to	generate	code	to	run	the	voltage	task.
1.	 Right-click	the	DAQ	Assistant	Express	VI	on	the	block	diagram,

and	select	Generate	NI-DAQmx	Code	from	the	shortcut	menu.
2.	 The	DAQ	Assistant	generates	all	the	code	necessary	to	run	the

task,	as	shown	in	the	following	block	diagram.

3.	 Save	the	VI	as	MyVoltageTask.vi.
4.	 Display	the	front	panel.	Click	the	Run	button	to	start	the

application.
Note		Any	changes	you	make	to	the	generated	code	apply	only	to
the	VI	and	are	not	saved	into	the	task	configuration	stored	in	MAX.

Previous:	5.	Edit	the	Task Next:	What's	Next



What's	Next
In	this	tutorial,	you	learned	how	to

Launch	the	DAQ	Assistant	by	using	the	DAQ	Assistant	Express	VI
in	LabVIEW
Configure	the	task	in	the	DAQ	Assistant
Test	the	task	using	test	panels
Edit	the	task
Generate	the	code	to	run	the	task



Related	Documentation
The	following	documents	contain	information	that	you	might	find	helpful
as	you	use	NI-DAQmx	and	LabVIEW:

DAQ	Assistant	Help—This	help	file	contains	information	about
using	the	DAQ	Assistant	to	interactively	configure	common
measurement	tasks,	channels,	or	scales.	In	LabVIEW	7.x	or	later,
LabWindows™/CVI™	7.x	or	later,	or	Measurement	Studio	7.x	or
later,	you	also	can	use	the	DAQ	Assistant	to	generate	NI-DAQmx
code	from	the	tasks	and	channels.
DAQ	Getting	Started	Guide—This	guide	describes	how	to	install
NI-DAQmx	driver	software	and	data	acquisition	(DAQ)	devices	and
how	to	confirm	that	the	device	is	operating	properly.
Getting	Started	with	LabVIEW—This	manual	contains	information
you	use	to	familiarize	yourself	with	the	LabVIEW	graphical
programming	environment	and	the	basic	LabVIEW	features	you
use	to	build	data	acquisition	and	instrument	control	applications.
Select	Start»All	Programs»National
Instruments»LabVIEW»Search	the	LabVIEW	Bookshelf.
LabVIEW	Help—This	help	file	contains	information	about	LabVIEW
palettes,	menus,	tools,	VIs,	and	functions.	This	help	file	also
includes	step-by-step	instructions	for	using	LabVIEW	features.	In
LabVIEW,	select	Help.
Measurement	&	Automation	Explorer	Help	for	NI-DAQmx—This
help	file	contains	information	on	configuring	and	testing	DAQ
devices,	SCXI	devices,	SCC	devices,	and	RTSI	cables	using
Measurement	&	Automation	Explorer	(MAX)	for	NI-DAQmx	and
information	about	special	considerations	for	operating	systems.	In
MAX,	select	Help»NI-DAQmx.

To	learn	more	about	tasks,	channels,	and	other	NI-DAQmx	concepts,
refer	to	the	NI-DAQmx	Help	located	at	Start»All	Programs»National
Instruments»NI-DAQmx	Help.
The	LabVIEW	Help	also	includes	information	about	creating	and	using
tasks	in	LabVIEW	and	reference	information	for	the	NI-DAQmx	VIs.
You	also	can	look	at	the	examples	that	ship	with	NI-DAQmx.	Use	the	NI
Example	Finder	located	at	Help»Find	Examples	to	search	for	examples
related	to	NI-DAQmx.
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Launching	the	DAQ	Assistant
When	you	configure	a	task	using	the	DAQ	Assistant	Express	VI,	the	task
is	local	to	the	application	and	is	not	saved	to	MAX	for	use	in	other
applications.	The	DAQ	Assistant	Express	VI	contains	the	code	you	need
to	run	the	task,	except	any	loops.	You	must	convert	the	DAQ	Assistant
Express	VI	to	an	NI-DAQmx	Task	to	save	the	task	to	MAX	for	use	in
other	applications.	You	can	also	generate	code	from	the	DAQ	Assistant
Express	VI.	Right-click	the	DAQ	Assistant	Express	VI	on	the	block
diagram	in	LabVIEW	and	select	Generate	NI-DAQmx	Code.
To	launch	the	DAQ	Assistant	from	a	task	name	control	in	LabVIEW,
complete	the	following	steps:

1.	 Open	a	blank	VI	in	LabVIEW.
2.	 Place	the	DAQmx	task	name	control	from	the	DAQmx	Name

Controls	palette	on	the	front	panel.
3.	 Right-click	the	control	and	select	New	NI-DAQmx	Task»MAX

from	the	shortcut	menu.
You	can	launch	the	DAQ	Assistant	from	MAX	in	the	following	ways:

Right-click	Data	Neighborhood	and	select	Create	New	from	the
shortcut	menu.	In	the	Create	New	window,	select	NI-DAQmx
Task.
Right-click	your	device	under	Devices	and	Interfaces	in	MAX	and
select	Create	New.



Converting	the	DAQ	Assistant	Express	VI	to	an
NI-DAQmx	Task
When	you	configure	a	task	using	the	DAQ	Assistant	Express	VI,	the	task
is	local	to	the	application	and	cannot	be	used	in	other	applications.	You
can	convert	a	DAQ	Assistant	Express	VI	to	an	NI-DAQmx	task	if	you
want	to	save	the	task	to	MAX	for	use	in	other	applications	or	to	generate
code.

Note		If	you	are	working	within	a	project	in	LabVIEW	8.0,
converting	the	DAQ	Assistant	Express	VI	to	a	task	saves	the	task
to	the	project.

Complete	the	following	steps	to	convert	the	DAQ	Assistant	Express	VI	to
an	NI-DAQmx	task.

1.	 Right-click	the	DAQ	Assistant	Express	VI	and	select	Convert	to
NI-DAQmx	Task	from	the	shortcut	menu.

2.	 The	DAQ	Assistant	launches,	and	you	can	modify	the	task,	if
necessary.

3.	 Click	the	OK	button.
4.	 An	NI-DAQmx	task	replaces	the	DAQ	Assistant	Express	VI.
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